
 
 
 

   

 

 

Microsoft Dynamics NAV  
 

Treemap Business Data 
Visualization for Microsoft 
Dynamics NAV 2009 SP1 

 

Partner Community Release 
 

 

 

 

December 2009 
 

 
 
 
 
 
 
 
 



 
 
 
 

      2 

 
PARTNER COMMUNITY RELEASE 

 
 

Table of Contents 

OVERVIEW ..................................................................................................................... 3 

BUSINESS DATA VISUALIZATIONS ............................................................................ 4 

TREEMAP BUSINESS DATA VISUALIZATION ....................................................................................... 5 

COMPONENTS IN THIS RELEASE ............................................................................... 6 

REDISTRIBUTABLE COMPONENTS ...................................................................................................... 6 
SAMPLE CODE ......................................................................................................................................... 6 
DOCUMENTATION ................................................................................................................................... 6 

INSTALLING AND RUNNING THE SAMPLE VISUALIZATION .................................... 6 

TREEMAP VISUALIZATION FEATURES IN THE DEMO DATABASE ......................... 7 

INTEGRATING WITH CUSTOMER DATABASES AND PARTNER SOLUTIONS ........ 9 

REDISTRIBUTABLE COMPONENTS ...................................................................................................... 9 
SAMPLE CODE ......................................................................................................................................... 9 

WALKTHROUGH: USING THE TREEMAP VISUALIZATION IN ANOTHER PAGE ... 11 

NEXT STEPS ................................................................................................................ 18 

  



 
 
 
 

3 

 
TREEMAP BUSINESS DATA VISUALIZATION FOR MICROSOFT DYNAMICS NAV 2009 SP1 

 
 

OVERVIEW 

The Treemap Business Data Visualization for Microsoft Dynamics
®
 NAV provides a unique view on 

business data. It can provide insight from different data perspectives and can be used to help identify 
outliers and actionable items. Combined with histogram-based visual filtering and integration into 
business logic and the user interface (UI) of the RoleTailored client, this is a powerful tool for end 
users. 

The Partner Community Edition release provides the Treemap visualization as a RoleTailored client 
control add-in for Microsoft Dynamics NAV 2009 SP1. It includes a server-side object, a codeunit for 
data processing, and a sample page. The sample uses the Treemap visualization control in a 
Treemap analysis place for customers. This place is a sample for how you can integrate the 
visualization into other application scenarios. 

You can use the Partner Community Edition of the Treemap Business Data Visualization for Microsoft 
Dynamics NAV to integrate the visualization into customer projects and your add-on solutions with 
Microsoft Dynamics NAV 2009 SP1. No dedicated granule is required. For details on the terms of the 
license, see the Software License Terms - Treemap Business Data Visualization.rtf file.  

The Partner Community Edition of the Treemap Business Data Visualization for Microsoft Dynamics 
NAV is an unsupported release. You can send an e-mail message with feedback on usability and 
suggestions for improvements to christian.abeln@microsoft.com. You can also see the Microsoft 
Dynamics NAV team blog or the dedicated add-in blog. We cannot provide assistance on specific 
issues with implementing Treemap visualizations in Microsoft Dynamics NAV, but your suggestions 
may be used to help drive improvements and provide additional information. 

This white paper describes how to use Treemap Business Data Visualizations in custom application 
scenarios. The guide starts with a high-level overview and then provides the steps to set it up for 
customer analysis. It describes the supported user interactions and provides step-by-step information 
for setting up and installing custom application scenarios. It also describes how to use the 
visualization add-in.  

  

mailto:christian.abeln@microsoft.com?subject=Feedback:%20%22Partner%20Community%20Edition%22%20of%20Treemap%20Business%20Data%20Visualization%20for%20Microsoft%20DynamicsNAV
http://blogs.msdn.com/nav/
http://blogs.msdn.com/nav/
http://blogs.msdn.com/cabeln
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BUSINESS DATA VISUALIZATIONS 

Business Data Visualizations for Microsoft Dynamics NAV are characterized by the following five 
pillars. 

· Picture your business (delivers mental models). 

Visualizations provide a mental model for business data and data dependencies. It can be 
characterized by the saying, “A picture is worth a thousand words.” By seeing a visual 
representation of data and data dependencies, even nonexpert users can more easily understand 
business data. 

· Understand your business; know state and trends (provides insight). 

Visualizations are an entry point for understanding the current state of a business and trends. 
Users can drill down and filter data to provide intuitive, ad hoc analysis. 

· Know how to act (identifies actionable tasks). 

Users can find items of interest and outliers in business data that are based on certain objectives 
or measures. Those outliers can be converted into high-priority actionable tasks and possible 
actions. 

· Act wisely (provides decision support, problem solvers, and optimization). 

Problem solvers and optimizers help users decide on a strategy. They can provide suggestions 
for an action strategy that can lead to an optimal result for one or more objectives. 

· Understand consequences (visualizes consequences before acting). 

Visualizations help users understand the impact of actions before they are committed. Visualizers 
can account for dependencies, predict the outcome of actions, and provide visualizations to 
users. 
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TREEMAP BUSINESS DATA VISUALIZATION 

The Treemap Business Data Visualization provides insight into business data. Users look at business 
data from different perspectives. In a Treemap visualization, a perspective is composed of two 
measurements, which define the appearance of size and color for each data element. The brain can 

efficiently process large sets of data based on 
size and color, which makes the Treemap 
visualization very effective. 

The Treemap visualization is complemented with 
visual filtering on top of a data histogram for 
each selected measurement. The histogram 
provides an overview of how many data items 
appear in the range of values that is defined by 
the full measurement value range. Users can 
then use intuitive range filtering to adjust the 
upper or lower boundary of the range of values 
from which data objects are visualized. 

With visual filtering, users can see data items 
disappear or appear dynamically and transition 
smoothly in size and color. The brain can follow 
and keep track of dynamic changes for a large 
number of visual elements simultaneously, which 
makes the visualization even more effective. 

Users can use these visual tools to better understand a set of business objects with the range of 
values of multiple measurements in one picture. Users can then discover unexpected 
correspondences and also validate that data follows presumed correspondences. 

The Treemap visualization also helps identify actionable items and answers to questions, such as 
which business data items fall out of typical procedures? Which data items are the most important 
ones to act on? Where does an action have the most impact? 

These questions can frequently be answered by looking at outliers in presumed correspondences of 
measurements for a business situation. These business data items typically do not follow the 
presumed correspondences and anticipated flow of data.  

The Treemap visualization provides direct access to relevant UI pages so that users can act on the 
business data object behind a Treemap field. 
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COMPONENTS IN THIS RELEASE 

The following components are included in the Partner Community Edition: 

REDISTRIBUTABLE COMPONENTS 

· Files for the Treemap visualization RoleTailored client control add-in in the Treemap visualization 
- Partner Community Edition folder. 

· The Microsoft.Dynamics.Visualizations.TreeMap.DataBuilder.dll assembly for server-side data 
processing. 

SAMPLE CODE 

· The TreeMapViz-PartnerCommunityEdition.fob file or TreeMapViz-PartnerCommunityEdition.txt 
file, which contain the codeunit and sample code. 

DOCUMENTATION 

· The Software License Terms - Treemap Business Data Visualization.rtf file, which contains the 
terms for using the Partner Community Edition release. 

· The Partner Community Edition - Treemap Business Data Visualization for Microsoft Dynamics 
NAV.pdf file, which describes what the Treemap visualization is, how to install it with the demo 
database, and how to use it with other pages. 

INSTALLING AND RUNNING THE SAMPLE VISUALIZATION 

The Partner Community Edition is delivered as a self-extractable archive. It includes a codeunit for 
generic data handling and a sample page to demonstrate the visualization in an application scenario. 

To perform a quick installation and run the sample visualization 

1. On the computer running all three tiers of Microsoft Dynamics NAV 2009 SP1 with the demo 
database, run the Treemap Business Data Visualization for Microsoft Dynamics NAV (ver 1.0.6, 
Partner Community Edition).exe self-extracting archive.  

By default, the files are installed to C:\Program Files\Microsoft Dynamics NAV\60\Treemap 
(Partner Community Edition) on a 32-bit edition of Windows

®
 or C:\Program Files (x86)\Microsoft 

Dynamics NAV\60\Treemap (Partner Community Edition) on a 64-bit edition of Windows. 

2. In the Classic client, on the Tools menu, click Object Designer. 

3. On the File menu, click Import.  

4. Locate the TreeMapViz-PartnerCommunityEdition.fob or TreeMapViz-
PartnerCommunityEdition.txt file, and then click Open. 

5. When no conflicts are found, click Yes to import all objects. 

6. In the Import Objects dialog box, click OK. 

7. In the Client Add-in table, add the following values in a new row to register the control add-in: 

· Control Add-in Name: TreeMapViz 

· Public Key Token: 31bf3856ad364e35 

· Version (optional): 1.0.6 

· Description (optional): Treemap Business Data Visualization - Partner Community Edition 

8. Open the following URL: dynamicsnav:////RunPage?Page=55555. 

dynamicsnav://RunPage/?Page=55555
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TREEMAP VISUALIZATION FEATURES IN THE DEMO DATABASE 

Page 55555 is a Treemap analysis place for customers. The Treemap visualization replaces the 
typical list-type representation for customers with the following color and size codes. 

· Color code: Customers with large values of the color measure are displayed in blue, small values 
are displayed in red, and average values are displayed in gray. 

· Size code: Customers with large values of the size measure are displayed as large rectangles, 
and small values are displayed as small rectangles. 

You can try the following interactions to better understand the UI concepts. 

· Select a measure for the Show color for and Show size for fields. Set the focus in one of the 
drop-down menus and use the UP ARROW and DOWN ARROW keys to step through the 
measures. The visualizations are animated and change when you step through them. 

· Click Customer List, and then click Advanced filter. Enter a filter row to see the visualization 
change to show the different set of customers in the dataset. 

· Set the focus on a cell in the Treemap, and then press the arrow keys to step through the cells in 
the visualization. When you move to another cell and wait for half a second, the FactBoxes are 
updated to show the details of the selected Treemap cell.  

· Double-click a cell or press ENTER on the selected cell. The Customer card for that customer is 
opened. 

· Experiment with the visual range filter for the color measure at the bottom of the Treemap and the 
size measure on the left side. Integrated histograms and the value legend provide an intuitive 
filtering experience. 

 

While dragging, hover over and drag the handles on the left and right side to change the range. 
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Hover over and drag the connection between the handles to move the range. Double-click the 
connection between the handles to revert to the full range or to the last reduced range. 

 

Note that if you range-filter out a number of customers for one measure, then the histogram for 
the other measure reflects the filtered-out customers through hatched brush filling of the 
respective bars in the histogram. 
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INTEGRATING WITH CUSTOMER DATABASES AND PARTNER 
SOLUTIONS 

REDISTRIBUTABLE COMPONENTS 

You can redistribute the Treemap visualization components to computers running the RoleTailored 
client and Microsoft Dynamics NAV Server. 

To manually install redistributable components for the RoleTailored client 

1. Navigate to the Treemap visualization – Partner Community Edition folder. By default, the files are 
installed at C:\Program Files\Microsoft Dynamics NAV\60\RoleTailored Client\Add-Ins.  

2. To manually distribute these files to a computer running the RoleTailored client, copy this folder to 
the Add-Ins folder on that computer. 

To manually install redistributable components for Microsoft Dynamics NAV Server 

1. Navigate to the Treemap (Partner Community Edition) folder. By default, the files are installed at 
C:\Program Files\Microsoft Dynamics NAV\60. 

2. To manually distribute these files to a computer running Microsoft Dynamics NAV Server, copy 
this folder to the 60 folder on that computer. 

3. Run the Register DataBuilder.cmd file to register the data builder component. 

4. Run the UnRegister DataBuilder.cmd file to unregister the data builder component to uninstall the 
Treemap visualization. 

SAMPLE CODE 

The Treemap visualization comes with a codeunit for generic data handling and a sample page that 
shows how to use the visualization in an application scenario. 

To import and customize the codeunit and sample page 

1. In the Classic client, on the Tools menu, click Object Designer. 

2. On the File menu, click Import.  

3. Locate the TreeMapViz-PartnerCommunityEdition.fob or TreeMapViz-
PartnerCommunityEdition.txt file, and then click Open. 

4. When no conflicts are found, click Yes to import all objects. 

5. In the Import Objects dialog box, click OK. 

6. In the Client Add-in table, add the following values in a new row to register the control add-in: 

· Control Add-in Name: TreeMapViz 

· Public Key Token: 31bf3856ad364e35 

· Version (optional): 1.0.6 

· Description (optional): Treemap Business Data Visualization - Partner Community Edition 

7. In Object Designer, locate codeunit 55555, Treemap AddInCode, and page 55555, Customer 
Treemap Analysis. You can renumber the objects for your database, and you can also use page 
55555 as a template for using the visualization in other pages. 

8. In Object Designer, click Page, and then find page 22, Customer List. 
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9. Add an action that that opens page 55555, Customer Treemap Analysis. For information about 
adding actions to page 22, Customer List, see Walkthrough: Adding Actions to a Customer List 
Page. 

· You can use the following values for the CaptionML property: 

DAN=Treemap-analyse;DEU=Treemap Analyse;ENU=Treemap Analysis;ESP=Análisis de 
Treemap;FRA=Analyse Treemap;ITA=Analisi Treemap;NLD=Treemap-analyse;FRC=Analyse 
Treemap 

· You can use the following values for the PromotedActionCategoriesML property: 

DAN=Ny,Proces,Rapport,Analyse;DEU=Neu,Vorgang,Bericht,Analyse;ENU=New,Process,Re
port,Analysis;ESP=Nuevo,Proceso,Informe,Análisis;FRA=Nouveau,Processus,État,Analyse; 
ITA=Nuovo,Processo,Report,Analisi;NLD=Nieuw,Proces,Lijst,Analyse;FRC=Nouveau, 
Processus,Rapport,Analyse  

10. On the action, set the PromotedCategory property to Category4, and then select an action 
image such as Segment.  

11. Run page 22, Customer List, and then see the Treemap Analysis action in the Action Pane. 

 

12. Click Treemap Analysis to run page 55555, Customer Treemap Analysis. 

 

http://msdn.microsoft.com/en-us/library/dd301058.aspx
http://msdn.microsoft.com/en-us/library/dd301058.aspx
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WALKTHROUGH: USING THE TREEMAP VISUALIZATION IN 
ANOTHER PAGE 

In the previous procedures, you have registered the Treemap visualization control add-in in the 
database and enabled the sample page, which runs the Treemap visualization on page 22, Customer 
List. In this walkthrough, you will: 

· Add the Treemap control add-in to a page. 

· Populate the Treemap with data. 

· Integrate the Treemap with filtering. 

· React to events from the Treemap control add-in. 

To add the Treemap control add-in to the Sales Order page 

First, you create a new Treemap visualization page for sales orders. 

1. In Object Designer, copy page 9305, Sales Order List, and change the page number to 55556 
and the page name to Sales Order Analysis. 

2. In Page Designer, open page 55556, Sales Order Analysis. 

On that page, a list appears like on a typical list place. You will make the Treemap visualization 
appear instead. 

3. Remove the <Control1> group of GroupType Repeater with all child fields and add one field for 
the Treemap visualization instead. 
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4. For the new field, select the TreeMapViz control add-in from the lookup for the ControlAddIn 
property. 

5. Save and compile the page. 

6. In Object Designer, select page 55556, Sales Order Analysis, and then click Run to display the 
following page. 
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To populate the Treemap control add-in with data 

Once you have updated the page, you must get data into the Treemap control add-in. The Treemap 
control add-in can process XML data of a certain format. 

1. Bind the XML data to a global variable on the page of type BigText. 

 

2. Populate the _xml variable with data, which you can do based on the sample code that is included 
in codeunit 55555.  

This codeunit has a MakeTreeMapXmlData method, which is generic and can be used on any 
table. It uses the Treemap Data Builder COM object to build valid Treemap XML data. 

The MakeTreeMapXmlData method optionally collects information about all fields in a table of 
type Decimal and includes this information in the Treemap XML data. The visualization uses this 
information to populate the drop-down field selectors for the size and color measures. A page that 
calls the MakeTreeMapXmlData method sends the setup information only once when it initializes 
the page. 

The MakeTreeMapXmlData method also adds the values for the two referenced fields of all rows 
in the table to the XML.  

This control add-in combines optional setup information and data to show in one XML data stream 
that is sent to the visualization control. You can use this as a best practice for your own 
visualization control add-ins. 
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3. Add a Sales Order–specific method to the page. 

PROCEDURE MakeTreeMapData@6(addSelectableMeasures@1005 : Boolean); 

VAR 

    myRec@1001 : Record 36; 

    recRef@1002 : RecordRef; 

    currentPos@1000 : Text[1024]; 

    colorField@1003 : FieldRef; 

    sizeField@1004 : FieldRef; 

    captionField@1006 : FieldRef; 

BEGIN 

    myRec.COPYFILTERS(Rec); 

    recRef.GETTABLE(myRec); 

    IF (_colorFieldNo >= 0) THEN 

      colorField := recRef.FIELD(_colorFieldNo); 

    IF (_sizeFieldNo >= 0) THEN 

      sizeField := recRef.FIELD(_sizeFieldNo); 

    captionField := recRef.FIELD(_captionFieldNo); 

 

    currentPos := Rec.GETPOSITION(); 

    recRef.SETPOSITION(currentPos); 

 

    _treeMapUtil.MakeTreeMapXmlData(recRef, 

                                    captionField, 

                                    colorField, sizeField, 

                                    addSelectableMeasures, 

                                    _xml); 

    END; 

4. Add code to page 55556. You can use the code in page 55555 as a template. 

OnInit=BEGIN 

          _captionFieldNo := 3; 

          _colorFieldNo := 60; 

          _sizeFieldNo := 122; 

       END; 

 

OnOpenPage=BEGIN 

               MakeTreeMapData(TRUE); 

           END;  

The new P55556.MakeTreeMapData method uses values for the currently selected field for color 
and size. That field is used to get the title in a Treemap field, and these values are maintained as 
global page variables and initialized in the OnInit function. The Treemap page calls the XML data 
generation the first time and includes the setup information for only this time in the OnOpenPage 
function. 
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5. Run page 55556, Sales Order Analysis, to display the Treemap visualization. 

 

To integrate the Treemap visualization with the Filter pane on the page 

You can filter the data that is displayed in the Treemap visualization with filters that you set in the 
Filter pane. When you change the filter, the Treemap visualization changes to reflect the updated 
data. It will remove or add Treemap fields, and it will also change size and color based on the updated 
data. 

To support filtering, you listen for changes in the OnFindRecord trigger and must implement the 
OnNextRecord trigger. When the filter changes, new XML data is generated for the Treemap 
visualization. However, the setup information is not sent each time. 

· Add the following code: 

OnFindRecord=VAR 

               found@1000 : Boolean; 

             BEGIN 

               found := Rec.FIND(Which); 

               IF (Which = '=><') THEN 

               BEGIN 

                 MakeTreeMapData(TRUE); 

               END 

               ELSE IF ((Which <> '-') AND (Which <> '+') AND (Which <> '=')) THEN 

               BEGIN 

                 IF (_lastFilters <> Rec.GETFILTERS()) THEN 

                 BEGIN 

                   _lastFilters := Rec.GETFILTERS(); 

                   MakeTreeMapData(FALSE); 

                 END; 

               END; 

               EXIT (found); 

             END; 

 

OnNextRecord=BEGIN 

               EXIT (Rec.NEXT(Steps)); 

             END; 
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To set up reacting to events from the Treemap control add-in 

The Treemap control add-in sends the following Treemap-specific messages through the 
OnControlAddIn trigger. 

Message ID Data 

 Measures changed  100  Two comma-separated field numbers 

 Treemap field activated  101  Record ID behind the Treemap field 

 Treemap field selected  102  Record ID behind the Treemap field 
 

If you change the measures on the visualization, then the Measures changed event occurs, and the 
Treemap gets fresh data for the selected fields. 

If you double-click a Treemap field or press ENTER in the currently selected field, then the Treemap 
field activated event occurs. The corresponding task page for the record that is underlying the 
Treemap field is opened. 

If you select a Treemap field with the mouse or keyboard, then the Treemap field selected event 
occurs. The page synchronizes the FactBoxes with the selected record. 

Note   There is built-in latency before sending the Treemap field selected event to ensure that 
the selection is intentional and that you are not cycling through the Treemap visualization with the 
keyboard. 

· Add the following code: 

   { 1   ;1   ;Field     ; 

                Name=<Treemap>; 

                CaptionML=ENU=<Treemap>; 

                SourceExpr=_xml; 

                ControlAddIn=[TreeMapViz;PublicKeyToken=31bf3856ad364e35]; 

                OnControlAddIn=BEGIN 

                                 HandleAddInMessage(Index, Data); 

                               END; 

                                } 
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The following code handles the messages from the Treemap control add-in: 

    PROCEDURE HandleAddInMessage@4(Index@1000 : Integer;Data@1001 : BigText); 

    VAR 

      pos@1005 : Integer; 

      myRec@1004 : Record 36; 

      recId@1003 : RecordID; 

      recRef@1007 : RecordRef; 

      myCard@1002 : Page 42; 

      txt@1006 : Text[30]; 

    BEGIN 

      CASE Index OF 

        // EVENTID_MeasuresChanged 

        100: 

        BEGIN 

          pos := Data.TEXTPOS(','); 

          Data.GETSUBTEXT(txt, 1, pos-1); 

          IF (NOT EVALUATE(_colorFieldNo, txt)) THEN 

            _colorFieldNo := -1; 

          Data.GETSUBTEXT(txt, pos+1, Data.LENGTH-pos); 

          IF (NOT EVALUATE(_sizeFieldNo, txt)) THEN 

            _sizeFieldNo := -1; 

          MakeTreeMapData(FALSE); 

        END; 

        // EVENTID_ItemActivated 

        101: 

        BEGIN 

          recRef.GETTABLE(myRec); 

          Data.GETSUBTEXT(txt, 1, Data.LENGTH); 

          EVALUATE(recId, txt); 

          IF (recRef.GET(recId)) THEN 

          BEGIN 

            recRef.SETTABLE(myRec); 

            myCard.SETRECORD(myRec); 

            myCard.RUN(); 

          END; 

        END; 

        // EVENTID_ItemSelected 

        102: 

        BEGIN 

          recRef.GETTABLE(myRec); 

          Data.GETSUBTEXT(txt, 1, Data.LENGTH); 

          EVALUATE(recId, txt); 

          IF (recRef.GET(recId)) THEN 

          BEGIN 

            recRef.SETTABLE(myRec); 

            CurrPage.SETRECORD(myRec); 

          END 

          ELSE 

            MESSAGE('Not Found: ' + txt); 

        END; 

      END; 
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NEXT STEPS 

You should be able to use the Treemap visualization in other scenarios. Find application scenarios 
that could benefit from using the Treemap Business Data Visualization, and work with your customers 
to try it out in real customer environments. Ask your customers and users how helpful the visualization 
is in performing their daily work. 
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